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Introduction 
 
The 1990 Nutrition Labeling and Education Act mandated nutritional labeling of most foods.  As 
a result, a large portion of food analysis is performed for nutritional labeling purposes.  A food 
labeling guide and links to the complete nutritional labeling regulations are available on line at 
http://vm.cfsan.fda.gov/~dms/flg-toc.html.  However, interpretation of these regulations and the 
appropriate usage of rounding rules, available nutrient content claims, reference amounts, and 
serving size can be difficult.   
 
Additionally, during the product development process the effect of formulation changes on the 
nutritional label may be important.  As an example, a small change in the amount of an 
ingredient may determine if a product can be labeled low fat.  As a result, the ability to 
immediately approximate how a formulation change will impact the nutritional label can be 
valuable.  In some cases, the opposite situation may occur and a concept called reverse 
engineering is used.  In reverse engineering the information from the nutritional label is used to 
determine a formula for the product.  Caution must be used during reverse engineering.  In most 
cases, only an approximate formula can be obtained and additional information not provided by 
the nutritional label may be necessary.  
 
The use of nutrient databases and computer programs designed for preparing and analyzing 
nutritional labels can be valuable in all of the situations described above.  In this laboratory you 
will use a computer program to prepare a nutritional label from a product formula, determine 
how changes in the formula affect the nutritional label, and observe an example of reverse 
engineering. 
 
Reading Assignment 
 
Nielsen, S.S., and L.E. Metzger. 2003. Nutrition labeling. Ch. 3, in Food Analysis, 3rd ed., S.S. 
Nielsen, Ed., Kluwer Academic, New York. 
 
Owl Software, 2008. TechWizard™ Version 4 Manual, LaVic, Inc., Columbia, Missouri. 
 
Objective 
 
Prepare a nutritional label for a yogurt formula, determine how formulation changes will affect 
the nutritional label, and observe an example of reverse engineering. 
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Materials 
 
TechWizard™ Version 4 - Formulation and Nutrition Labeling Software 
PC with Microsoft® Excel 2000, Excel 2003 or Excel 2007 
 
Notes 
 
Instructions on how to receive and install the software used for this laboratory are located on line 
at www.owlsoft.com.  On the left hand side of the web page click on the Food Analysis Students 
link located under the services heading.  It is possible that the TechWizard™ program has 
been updated since the publication of this laboratory manual and any changes in the 
procedures described below will also be found on this web page. 
*Install the software prior to the laboratory to ensure that it is working properly with your 
PC. 
 
METHOD A. PREPARE NUTRTION LABELS FOR THE SAMPLE YOGURT  
  FORMULAS 

 
Procedure  

 
Table 1. Sample yogurt formulas 
 Formula #1 (%) Formula #2 (%) 
Milk (3.7% fat) 38.201 48.201 
Skim milk 35.706 25.706 
Condensed skim milk (35% TS) 12.888 12.888 
Sweetener, sugar liquid 11.905 11.905 
Modified starch 0.800 0.800 
Stabilizer, gelatin 0.500 0.500 

 
1. Start the TechWizard™ program (Excel 2000-2003: Click on the Enable Macros button. 

Excel 2007 or higher: Click on the Options button and select Enable Content ) and select 
Enter Program from the Main menu (Click on OK, select the user Administrator and click on 
OK).  Enter the Nutrition Labeling section of the program (Excel 2000-2003: Click the 
Labeling menu, select View, and click Labeling Section. Excel 2007 or higher: Click on the 
Labeling tab and click Labeling Section from the View group) 

 
2.  Enter the ingredients for formula #1 listed in Table 1. (Click on the Add Ingredients button, 

then select each ingredient from the ingredient window and click on the Add button, click on 
the X to close the window after all ingredients have been added.) 

 
3. Enter the % of each ingredient for formula #1 in the % (wt/wt) column and sort the 

ingredients by the % (wt/wt) in the formula. (Select the Sort button. In the window that 
appears, click the Sort Descending button. Answer Yes when prompted. Close the window).  

 
4.  Enter the serving size (common household unit and the equivalent metric quantity) and 

number of servings. (First click on the Serving Size button under the Common Household 
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Unit, enter 8 in the window, click on OK, select oz from the units drop down menu; next click 
on the Serving Size button under the Equivalent Metric Quantity, enter 227 in the window, 
click on OK, select g from the units drop down menu; and finally click on the Number of 
Servings button, enter 1 in the window, click on OK.) 
*Note by clicking on the Show Ref. Table button, a summary of the CFR 101.12 Table 2 
Reference Amounts Customarily Consumed Per Eating Occasion will be displayed. 
 

5.  Enter a name and save formula #1. (Click on the Formula Name & ID window, enter "food 
analysis formula #1" in the top window, click on the X to Close the window, from the File 
menu/tab select Save Formula.) 

 
6.  View the nutrition label and select label options (click on the View Label button, click on the 

Label Options button, select the label type you want to display – the standard, tabular, linear 
or simplified format can be displayed; select the voluntary nutrients you want to declare – you 
may want to select Protein - Show ADV since yogurt is high in protein; The daily value 
footnote and calories conversion chart will be displayed unless Hide Footnote and Hide 
calorie Conversion Chart are selected; when you have finished selecting the label options 
select Apply and then Close to view the label). 

 
7.  Edit the ingredient declarations list (Click on the View/Edit Declaration button, click Yes 

when asked – Do you wish to generate a formula declaration using individual ingredient 
declarations? – Each ingredient used in formula can be selected in the top window and the 
ingredient declaration can be edited in the middle window.) 
*Note the rules for ingredient declaration are found in the CFR 101.4 
 

8. Print the nutrition label for formula #1 (click on the Print Label button, select Nutrition Label 
and click Print, to return to the label format menu, click on the Close button). 

 
9. Return to the Nutrition Info & Labeling section of the program (click on the Return button). 
 
10. Enter the % of each ingredient for formula #2 in the % (wt/wt) column. 
 
11. Enter a name and save formula #2 (Click on the Formula Name & ID window, enter "food 

analysis formula #"2 in the top window, click on the X to Close the window, select Save 
Formula from the File menu). 

 
12. View and print the nutrition label for formula #2 (click on the View Label button, click on the 

Print Label button, select Nutrition Label then click on Print; to return to the label format 
menu click on the Close button). 

 
 
METHOD B.  ADDING NEW INGREDIENTS TO A FORMULA AND DETERMINING  

  HOW THEY INFLUENCE THE NUTRITION LABEL 
 
Sometimes it may be necessary to add additional ingredients to a formula.  As an example, let us 
say you decided to add an additional source of calcium to yogurt formula #1.  After contacting 
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several suppliers you decided to add Fieldgate Natural Dairy Calcium 1000 produced by First 
District Association (Litchfield, MN) to the yogurt formula.  This product is a natural, dairy 
based whey mineral concentrate and contains 25% calcium.  You want to determine how much 
Dairy Calcium 1000 you need to add to have 50 and 100% of the Daily Value of calcium in one 
serving of your yogurt.  The composition of the Dairy Calcium 1000 you will add is shown in 
Table 2.  
 
Table 2. Composition of Fieldgate Natural Dairy 
Calcium 1000 (First District Association) 
 
Component Amount 
Ash 75% 
Calcium 25,000 mg/100g 
Calories 40 cal/100g 
Lactose 10% 
Phosphorus 13,000 mg/100 g 
Protein 4.0% 
Sugars 10 g/100 g 
Total Carbohydrate 10 g/100 g 
Total Solids 92% 
Water 8.0% 

 
Procedure 
 
1. Go to the Formula Development Section. (Excel 2000-2003: Click the Formula Dev menu, 

select View, and click Formula Dev. Excel 2007 or higher: Click the Formula Dev and 
Batching tab and click Formula Dev from the View group.)   

 
2. Add the new ingredient to the database. (Excel 2000-2003: Click the File Menu, select 

Ingredient Files, and click Edit Current Ingredient File. Excel 2007 or higher: Select the Edit 
Ingredient File tab and click Edit Current File from the File group.) Enter the name of the 
new ingredient. (Excel 2000-2003: Select the Edit Ingredients menu and click Add. Excel 
2007 or higher: Select the Edit Ingredient File tab and click Add from the Ingredients group. 
Enter the ingredient name - "Dairy Calcium 1000", click Add.  When prompted to update the 
ingredient file enter Yes, click on the X to Close the window). Enter its composition (Find 
Dairy Calcium 1000 in the list of ingredients in the spreadsheet and select it. Excel 2000-
2003: Select the Edit Ingredients menu and click Edit Selected. Excel 2007 or higher: Select 
the Edit Ingredient File tab and click on Edit Selected from the Ingredients group. The row 
turns blue.  Enter the amount of each nutrient in the appropriate column.) 

 
3. Edit the ingredient declaration (what will appear on the ingredient list) for the new ingredient. 

(With the row still blue, enter the ingredient declaration "whey mineral concentrate" in the 
Ingredient Declaration column, click the Enter key on your keyboard, click on the Finish Edit 
button and select Yes.) 

 
4. Close the ingredient file. (From the File menu select Close Ingredient File.) 
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5.  Open food analysis formula #1 in the Formula Development section of the program. (Excel 

2000-2003: Click the File menu and select Open Formula. Excel 2007 or higher: Click the 
File tab and click Open Formula from the Formula group. Select Food analysis formula #1, 
click on the open button, click on Yes for each question.)  

 
6. Add the new Dairy Calcium 1000 ingredient to "food analysis formula #1". (Click on the Add 

Ingredients button, then select Dairy Calcium 1000 from the list, click on the Add button, 
click on the X to close the window.) 

 
7. Calculate the amount of calcium (mg/100g) required to meet 50 and 100% of the DV (see 

example below). 
 
Calcium required = (DV for calcium/serving size) x 100 g x % of DV required 
Calcium required for 50% of the DV = (1000 mg/227 g) x 100 g x 0.50 = 220 mg/100 g 

 
8. Enter the amount of calcium required in the formula and restrict all ingredients in the formula 

except skim milk and calcium phosphate. (Find calcium in the Properties column and enter 
220 in the Minimum and Maximum columns for calcium - this lets the program know that you 
want to have 220 mg of calcium per 100 g.  In both the Min and Max columns of the formula 
ingredients enter 38.201 for milk (3.7% fat), 12.888 for condensed skim milk (35% TS), 
11.905 for sweetener, sugar liquid, 0.800 for modified starch, and 0.500 for stabilizer, 
gelatin - this lets the program adjust the amount of skim milk and calcium phosphate and 
keeps the amount of all the other ingredients constant.  Click on the Formulate button, click 
OK.) 

 
9.  Transfer the new formula (with added calcium phosphate) to the Nutrition Label section of 

the program. (Excel 2000-2003: Click the Formula Dev menu and select Create Nutrition 
Label. Excel 2007 or higher: Click the Formula Dev and Batching tab and click Create 
Nutrition Label from the Formula group. Click Yes or OK for each of the questions.) 

 
10. View and print the nutritional label for the new formula for 50% of the calcium DV. (Click 

on the View Label button. Click on the Print Label button, select Nutrition Label then click 
on Print; click on the Return button to return to the Nutrition Info & Labeling Section.) 

 
11. Produce a formula and label that has 100% of the calcium DV. (Repeat Steps 1, 7- 11 except 

use the calculated amount of calcium required to meet 100% of the calcium DV - you will 
have to perform this calculation yourself by following the example in Step 7.) 

 
 
METHOD C. AN EXAMPLE OF REVERSE ENGINEERING 
 
Procedure 
 
In this example the program will automatically go through the reverse engineering process.  Start 
the example by selecting Cultured Products Automated Examples from the Help menu and 
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clicking on example #4.  During this example you proceed to the next step by clicking on the 
Next button. 
 
1. The information from the nutrition label for the product you want to reverse engineer is 

entered into the program. (Comments: In this example serving size, calories, calories from 
fat, total fat, saturated fat, cholesterol, sodium, total carbohydrate, sugars, protein, vitamin 
A, vitamin C, calcium, and iron are entered.) 

 
2. The minimum and maximum levels of each nutrient are calculated on a 100-g basis. 

(Comments: The program uses the rounding rules to determine the possible range of each 
nutrient on a 100-g basis.) 

 
3. The information about nutrient minimum and maximums is transferred into the Formula 

Development section of the program. (Comments: The program has now converted nutrient 
range information into a form it can use during the formulation process.) 

 
4. Ingredients used in the formula are then selected based on the ingredient declaration statement 

on the nutrition label. (Comments: Selecting the right ingredients can be difficult and an 
extensive understanding of the ingredient declaration rules is necessary.  Additionally some 
of the required ingredients may not be in the database and will need to be added.) 

 
5. Restrictions on the amount of each ingredient in the formula are imposed whenever possible. 

(Comments: This is a critical step that requires knowledge about the typical levels of 
ingredients used in the product.  Additionally, based on the order of ingredients in the 
ingredient declaration, approximate ranges can be determined.  In this example the amount 
of modified starch is limited to 0.80%, the amount of gelatin is limited to 0.50%, and the 
amount of culture is limited to 0.002%.) 

 
6. The program calculates an approximate formula. (Comments: The program uses the 

information on nutrient ranges and composition of the ingredients to calculate the amount of 
each ingredient in the formula.) 

 
7. The program compares the nutrition information for the developed formula to the original 

nutrition label. (Comments: This information is viewed in the Reverse Engineering  section of 
the program accessed by selecting the Reverse Engineering Section menu/tab, then  from the 
View menu/ group, clicking Reverse Engineering Section.) 

 
Questions 
 

1. Based on the labels you produced for yogurt formula #1 and formula #2 in Method A, what 
nutrient content claims could you make for each formula (a description of nutrient content 
claims is found in Table 3-7 and 3-8 in the Nielsen Food Analysis text)? 

 
2. How much Dairy Calcium 1000 did you have to add to the yogurt formula to have 50 and 

100% of the DV of calcium in the formula? 
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3. If Dairy Calcium 1000 costs $2.50/lb and you are going to have 100% of the DV for calcium 
in your yogurt, how much extra will you have to charge for a serving of yogurt to cover the 
cost of this ingredient? 

 
4. Assume you added enough Dairy Calcium 1000 to claim 100% of the DV of calcium, would 

you expect the added calcium to cause any texture changes in the yogurt?  
 
5. Make a nutrition label for your favorite chocolate chip cookie recipe.  You will have to 

gather several pieces of information including: the weight of each ingredient (not cups, tsp, 
etc), the composition of any ingredient that is not in the database, and moisture loss that 
occurs during baking. 
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